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MedsCheck Reviews - Ontario

This document outlines how to configure MedsCheck Review functionality in Kroll and the
process of completing MedsCheck Reviews for both paper based and electronic records.

Configuration

This section explains the configuration settings that must be in place before attempting to use
the MedsCheck functionality.

Configuring Electronic Signatures

NOTE: Only complete this section if you are using Electronic Signature pads.

Before you can begin configuring electronic signatures, Allow Electronic Signatures must be
enabled in File > Configuration > Kroll > Configuration. This will require a support call and must
be completed before proceeding.

o Kroll Configuration Parameters |,E.|Lﬂ_hJ
General Qonfiguration| Modulesl IherapeuticAdvisorl gtationl Logging|

I Allow Electronic Signatures I Follow Provincial Legislative Rules for Fx Transfer
[C] Enable SetLaser labels
[T Allgw NDC

1. Go to File > Configuration > Store > General.

2. Place a checkmark next to Allow Electronic Signatures.

= P

=’ Store Level Configuration Parameters

General Palientl Drug I Doctorl Rx | FDB | Adiudicationl Labelsl Fleportsl Securit_l,ll Interfacesl Elrderl X-AFII Y-Ta Do| [Ectrl E

Allovs User Calors [ Ahways Show Scan [ Diizplay window ‘When Services are Dawn
Allovs Column Configuration

Prompt to exit when clozing fill application Uze automatic capitalization

Enable MH / batch . )
e - Uze Unit Dose Packaging Allow Electionic Signatures |
Default language | Engiish J Default area code Enable Ctr-FrintS creen to Print Soreenshot
Defaut Cauntry Canada ﬂ Sort A% Transfer Stores By Store Mame j

Staore Information

3. Click OK to save the changes.
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Configuring Electronic Medication Reviews

1. Go to File > Configuration > Store > Rx > Counseling > Med Reviews/Dialogs.

w’ Store Level Configuration Parameters E =

| Generall F'atientl Drug I Doctorl Rz I FDB I .-’-‘«diudicationl Labelsl Heportsl Securityl Intelfacesl Drderl ><-AF|| Y- Ta Do| [ECtrl @

| e Generall 2- F'ricingl 3- Promplingl 4 - Mursing Homel 5 - Background Fx FiIIingI E- Workflowl i- CDUHSEHHQI a- EeFI:-:|

R Caunzeling Autarnatic Patient Counzeling
Allow editing counseling time On Mew R
Require Electronic Signature Ornly flag if patient hasn't had the drugin the last 180 daps
Uszers Permitted to Finalize Accepted Counseling [C] Or Refils
Fharmacist Licersed Technician [] On Drug Changes
Pharmacist Intern Pharmacy Tech Student Allows Uger bo Turn OFF Automatic Coungeling for an Bx
Fharmacy Student Pharmacy LAssiztant
IT Suppart
Yizible Tabs
Hardcopy Tab R Images Tab
RxTab “wiorkflow Tab
Financial Tab Packaging Tab

Med Reviews/Dialogs

Reguire Document Scan to Complete Paper Med Review
Enable Electronic Med Reviews

Fequire Electronic Signature

Allow Editing Caunzeling Time

T

2. Inthe Med Reviews/Dialogs area above, ensure the following options are set appropriately.

o Require Document Scan to Complete Paper Med Review: this option allows you to
complete paper-based MedsChecks using the document scan functionality;

e Enable Electronic Med Reviews: enabling this option allows you to use the electronic
version of MedsCheck;

e Require Electronic Signature: enabling this option prompts for electronic signatures
where necessary (only if you are using Electronic Signature pads).

e Allow Editing Counseling Time: this option allows you to modify the system-calculated
amount of time it took to complete the counseling session.

3. Click OK.
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NOTE: If you turn off the Require Electronic Signature option and keep the other options
enabled you will still be able to complete the reviews on-screen. However, you will need to
print the report, in order to capture pen-to-paper signatures and then scan it back into the
system before giving it to the patient.

Electronic MedsCheck Reviews

This section explains how to perform an Electronic MedsCheck review. Ensure your system is
configured for Electronic Medication Reviews before proceeding. See Paper MedsCheck Review
for information on the non-electronic process.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring ODB MedsCheck Prompt

The system prompts for MedsCheck when the option Prompt for ODB Med Checks is enabled
under File > Configuration > Store > Rx > Prompting.

= Store Level Configuration Parameters = 2

| Generall F'atientl Dirug I Doct0r| R | FDB I ﬁdiudicationl Labelsl Fleportsl Securityl Interfacesl Drderl X-AH' ¥ -To Do| ECtrI E

1- Generall 2 - Pricing] 3+ PfDthin9| 4 - Mursing Homel 5 - Background Rz FiIIingI B -Workflowl 7- Eounselingl 8- EeF!x|
Drug Prograns

[] Prompt to use Drug Subs (7] Autamatically use Drug Subs [C] Participats in the Rx Canada / Health Infarm Program

[] Use Drug Subs when Batching

[ Prompt If Doctor Refused Repeat When Cancelling Rix [] Participate in the Pharmacy Access program

Prormpt far Comments when Cancelling an Rx [] Use Station Mame Subdirectaries For Pharmacy Access
[] Always require comment Daysz Back: 365

Prompt for Comments when [nactivating an Fx [] Enable Rx Canada Frogram [F=Gateway)

[] Ahways require comment

[ Prompt far Patient Counseling an new Rz . . . i !
7] Prompt to Batch NH R [ Prompt ta Enrol Patients in Refill Reminder or Auta Refil Program

fompt to b ate ] Hs_ , . Prompt o Enrol MH Patients in Refil Beminder or Auto Refill Program
Prompt when nat dispenzing as drug's Pack Size [ Prompt ta Enable Rxs for Refil Reminder and Auta Refill Pragram

[E] Prompt For Repeats Wher? Copying an R § Enral Patients for Pickup Notification Mo ﬂ
[] Prampt Te Use Manual Price From Last Refill

Services

[7] Remave Manual Price for Batched Rixs Enral MH Patients for Pickup Notification Mo j
[ Prampt if Doctor Autharization Received for Marcotic Fixs
[ Check. for High Intensity Drugs Frampt to copy workflow packaged info for cancel and refill Rxs
rompt if there is not enough inventory to fill the Ry rompt to copy to new number if refiling an Rx with no repeats
(V] Frompt if th b h tary ta fill the: A [¥] Frompt & t ber if redill Rix with i
[ Prevent Copying an Inactive Ry ta a Mew Mumber Prompt for Due Date on autafill batches
[ Show local patient profile on fill [] Prampt for T= comment an autafill batches
Frompt to Copy "Mistake' Rxs to a New Mumber Save Route code from Rx as default value if no default is sst sk j
[ Show thermal/dot matrix label config on autofil
Save Form code from Ax a5 default value if no default is set Ask j
rompt to Print Script Image for 1st Fill of an Unfiled Rz utomatically &pply Elston For Eligible Products (Do not prompl
Prompt ta Print Script | far 13t Fill of an Unfiled R [J] Automatically Apply Elstan For Eligible Products [Do nat i

[ Prampt far A4DL Plan Infarmation if S4 number is NOT set I . F'rom:l for ODB Med Checks I

7] Force ODE Fee Restiictions |1 Track ODE Med Checks Rejection Reasons
[7] Prompt if was Undeliverable when Canceling an Rx [T Allows Newer Prampt Far ODB Med Checks

T
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When the option ‘Prompt for ODB Med Checks’ is enabled, the system screens each patient for
MedsCheck eligibility every time an Rx is processed. If the patient is eligible, the user is
prompted and presented with a number of options as shown below.

w* Select an Qption E P

This patient may be eligible for the MedsCheck Annual Review program.

| Add to Med Review Queue |

| Do not prompt me until the next time the patient comes in. |

| Do not prompt until ... |

| Never Prompt for this patient |

| Undecided |

o Add to Med Review Queue: Selecting this option adds the Med Review record to the
Medication Reviews queue which can be accessed from the Patient record or
F9 — Workflow. See section ‘Completing MedsCheck ‘Saved for Later’ for further details.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

e Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.

e Undecided: The prompt will re-appear once again the next time a prescription is filled
for the patient.
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Creating an Electronic MedsCheck Review (Manual)

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities NH  Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor l F9 - Workflow “ F10 - Pickup “ F11 - Drop-off “ F12 - New Rx “ Alt-X - Start
Last Mame Kroll First Name Test Salutation j _ Save Ratient
Address1 123 Any Street Phone Numbers (1) Birthdate 21,03/1950 EichE)
Description |Phone | All Res
Address 2 Age 64 years
J J Home (355) 766-8043 J Active Rxs
City Toronto | Prov ON = Gender Female - i i
- No Jiggeitaiiable Active Rxs w/Passtimes
Postal ALK 4X5 Country Canada j Language English j -
Refillable Rxs
Email Family Doctor Height L.
Pricing Profile
Quick Code KROLL Anthes, David Weight [ Ltoad [ Delete | Not Disp./OTC Ris
S
Comments (0) (Del)
— ([E@09 opg 9599999999999 Rus Filled in Error
Topic Comment
Flans (1) (F2) (=) (0e) Suspended Rxs
| subpian code| Group ID | client 1D |ewiy | -
1/ oDB 999999999999 31/12/2014 Perform FDB Analysis
View
Alternate Addresses
= AR Profile
Benes| (2] [F2)itvsi(Bel) - Geperal l Eamily ] Nursing Home] Copa},rgl Commgnications] Other ] GEdE
Acacia (Acacia Senegal, Gum Arabic) ; Batches
- Patient Consent
Ammaonium Acryloyldimethyltaurate, WP C Active Consent Unknown Charting
f Consent
A |
nimal [ Unit Dose Credit Card
Deceased On Type <None> j redit Cards
Medical Conditions (1) Ins] (Del] — Documents
. o Prescriptions Cycle <Mone» -
Acute Intestinal Amebiasis ) Medication Review/Dialogs (0) I
Delivery Type  Default (Pickup) j Price Group  <Default> (<None>)j
Delivery Route v‘ . Rx Counseling History

3. The Medication Review profile will appear. Click N — New Review/Dialog.

w# Patient - Helvey, Ricky *C B|= = K
File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor F9 - Worlkflow F10 - Pickup “ F11 - Drop-off ” F12 - New Rx " Alt-X - Start
Last Name Helvey First Name Ricky salutation j _ Save Patient
" N Profile
N - New Review/Dialog Al R
Medication Reviews (0] [zl Active Rs
Type Status Fee Status Created ¥ | Completed | Active Rxs w/Passtimes
Refillable Rxs
Pricing Profile

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown
menu and click Perform Now. If you wish to add to the Med Review queue in order to
complete the Medication Review later, click Save for Later.

By ==
E

w® Medication Review/Dialog

Type MedsCheck Annual Review

I Perform mowl [ Save for later l ’ X cancel l
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5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the
Rxs you want included in the report. When you are finished, click OK.

w° Medication Review Rx Selection P E|=B] X
Pre-Selected (3) | Other Rxs | Unfills | Not Dispensed | Discontinued
Rx Mum Drug Fill Date
1000958 Amoxicillin 50/ml 11-Jul-2014
1000957 Prinivil 2.5mg 11-Jul-2014
1000956 Synthroid 112mcg 11-Jul-2014
Select All ] ’ Select None ]
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default j
v oK

6. The MedsCheck Annual Review screen will appear. Click Next to proceed through the tabs,
completing the required fields as you go.

NOTE: The type of review that is displayed on screen depends on what type of review was
selected in Step 4. In this example, the MedsCheck Annual Review screen appears.
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Questions

The Questions tab includes a list of questions that the pharmacist is to ask the patient to better
understand their situation. Answers are recorded by selecting the appropriate option from each
dropdown menu.

Questions IMedicaI History | Non-Prescription Medications | Rxs From Other Pharmacies. | General Comments | Pharmacist Ccmments|
Have you received a MedsCheck review from another pharmacy in the last 12 months Ne j =
Medical Devices - BP Machine Mo j

Medical Devices - Glucometer Mo j

Medical Devices - Aero Chamber Mo j

Medical Devices - Other Yes j Allergy Pump

Alcohol Intake Moderate j )
Caffeine Intake Heavy j )
Smaoking Past j

Do you have trouble remembering to take medications as prescribed Yes j

Da you think you might benefit from a compliance pack program No j

Do you stop taking medication because of unwanted side effects Yes j

Do you change/adjust dosages without consulting your doctor or pharmacist Yes j

N A rancult vane nharmarict hafara nurchacina OTC tharhale fennnlamant nradincte ha - i

Medical History

The Medical History tab displays the medications that have been selected on the Medication
Review Rx Selection screen.

| Questionsl Medical History I MNon-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

Ins

Patient Medical History

Currently Taking

Yes j

Currently Taking

Yes j

Currently Taking

Yes j

7 TAB Synthroid 112mcg [KNO]

Pink Round Tab Flint 112

Dr. Moultrie, Filipe

Last Fill Date: 14-Jul-2014, Days Supply: 7
TAKE 1 TABLET ONCE DAILY

30 TAB Prinivil 2.5mg [MSD]

Dr. Moultrie, Filipe

Last Fill Date: 14-Jul-2014, Days Supply: 30
TAKE 1 TABLET EVERY MORNING

7 ML Amoxicillin 50/ml [SNS]

Dr. Moultrie, Filipe

Last Fill Date: 14-Jul-2014, Days Supply: 7
TAKE 1 TEASPOON(3ML)ONCE DAILY

Indications
Comments
ndications

X save for Later
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For each medication listed:

¢ Note if the patient is currently taking the specified medications and select Yes/No from
the dropdown list.

e Enter the reason for using the medication based on the patient’s feedback in the
Indications field.

e Enter any general comments in the Comments field.

Use the Del button to delete a record from the Medical History tab.

Non-Prescription Medications

The Non-Prescription Medications tab provides space to record any OTC/non-prescription
medications the patient is taking.

Click Ins to add a non-prescription medication to the tab.

Questions | Medical Historyl Non-Prescription Medications I Rxs From Other Pharmacies | General Comments | Pharmacist Comments

Non-Prescription Medications / Herbals / Supplements 1ns |[Del
Currently Taking  Claritin 10 mg For seasan allergies
Yes j

X save for Later @ Next

¢ Note if the patient is currently taking any OTC medications and select Yes/No from the
dropdown list.

e Enter the name of the medication in the Medication field.

e Enter any appropriate comments in the Comments field.

Use Del buttons to remove any OTC items.
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Rxs From Other Pharmacies

The Rxs From Other Pharmacies tab provides space to record medications that the patient is
taking that were filled in other pharmacies.

Click Ins to add an Rx from another pharmacy.

| Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

Prescriptions From Other Pharmacies

From - Smith's Pharmacy - (555) - 123-4567

Currently Taking  Tylenol # 3 - Take 1 to 2 tablets up to 4 times a
Possible duplication of therapy

Yes j day when needed for pain

From - Duncan Mill Pharmacy - (355) - 555- 5555

Currently Taking  gisoprolol 5mg - take 1 tablet daily
Duplication of therapy

Yes -

Note if the patient is currently taking any other medications and select Yes/No from the

[ J
dropdown list.

e Enter the name of the medication in the Medication field.

e Enter any appropriate comments in the Comments field.

Repeat the same process for any Rx items that they have purchased from other pharmacies.

Use Del buttons to remove any Rx items.
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General Comments

The General Comments tab provides space to record any comments you want included on the
report printout.

| Questions | Medical History | Non-Preseription Medications | Rxs From Other Pharmacies | General Comments | pharmacist Comments |

Pharmacist Comments

© Next

The Pharmacist Comments tab provides space to record any comments that the pharmacist
wishes to enter concerning the medication or patient in the free form.

| Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments |

[ |
—— [ ]

7. When you are finished click Finalize Review.

10
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8. The Medication Review prompt will appear. If you have Allow Editing Counseling Time
enabled, enter the amount of time it took to complete the review in the Time spent field.

The Assessment Location information is pre-populated with the pharmacy information. If
the MedsCheck was physically conducted in another location (LTC facility, patient’s home)
other than the pharmacy, enter the name of the location and the address. Complete the

Other Professional Involved fields if another health professional assisted with the review.

When you are finished, click OK.

=¥ Medication Review E PS

Time spent: 00:30 On 14/07/2014 By Pharmacist (P) j

Assessment Location

Name Kroll Pharmacy
Address 220 Duncan Mill Road, Suite 201, Toranto, ON M3B 315

Other Professional Invaolved

MName T
Title Technician

Phone

L_«vok | [ X Cancel ]

Affixing an Electronic Signature

NOTE: If you do not have an electronic signature configured, print the Medication Review
Report, have both the patient and the pharmacist sign the report, and scan it back into the
system.

9. Have the patient sign his or her name on the electronic signature tablet. Click the OK button
on the signature tablet.

11
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The patient signature appears once the patient signs on the electronic signature tablet.

10. Have the pharmacist sign the electronic signature tablet.

N

11. When you are finished, tap Done on the signature tablet.

Printing a MedsCheck Review

12. A prompt will appear asking if you want to print a paper copy of the electronic Medication
Review. Click Yes.

13. The MedsCheck report print form will appear. Select the appropriate print options and click
Print and provide this copy to the patient.

12



\//X !Sm,?.?,!;.'- MedsCheck Reviews - Ontario

Billing a MedsCheck Review

14. Once printing is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

NOTE: If the user account of the pharmacist logged into the terminal during the processing
of the MedsCheck includes a license number that is identical to the license number of a
Prescriber card in the Doctor file, then the Prescriber field on the F12 screen for the claim
will be populated with that prescriber.

15. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

File Edit Rx View Labels Profile Reports Utilities NH Cards Session Help
‘ F3 - Patient H F5 - Drug H F7 - Doctor ‘ F2 - Workflow F11 - Drop-off I F12 - Fill Rx || Alt-X - Start ‘
= = First Fill Last Fill Information
0 NewRx | Pending Adj 200814 || 0 0 Qty $0.00/ Init [ & Lookup ” X Cance||
Priority Default Wait Time ~[rz] pue in 19 mins Forward Rx  [F2] Work Order 0 [Fz] Delivery Pickup ~|
Patient Search Drug Search Pack 100 j Daoc Search Loc Office j
Name | Done, Jane Age34  |Brand ODB MedsCheck Mame | Dr. Pharmacist, Test
Address | 100 Yonge Street Female | | Generic Annual Review Address 100 King Street
City Toronto Frov |ON Pack 100/ Form Sched City Toronto Prov ON
Phone |Cell (555) 555-5555 ODB(MALC) OnHand |0 Noimage || Phone |(555) 555-5555
Plan 0DB Client 1D 111111 DN 00888020 | Min Qty 0 Licg 12345 Al Licg
Allergies Sig MEDSCHECK ANNUAL REVIEW it [PM|PM AuthQy 1 1
MEDSCHECK ANNUAL REVIEW Disp Oty 1 Refills(+)| RemQty | 1) 1
G.P. 2% 100
Days 1
g Acq Cost 50,00
Conditions I G Pharm:j Cost £0.00
Coute of Adm B oW written | pin S0
see s aemn Labels  1[F2] Fee §10.49
Przzalizm = Total §10.49

13
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MedsCheck Review Options

Several MedsCheck review options are available from the right navigation pane on the

MedsCheck Annual Review screen.

Allergies Cenditions

File Edit Med Review View Profile Utilities Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor F9 - Workflow F11 - Drop-off F12 - New Rx
MedsCheck Annual Review Reviewed With | Doe, Jane (In Person)
Patient | Doe, Jane Address | 100 Yonge St
Birth 01/01/1980 | 34 years Female | Plan | ODB ClientID | 1111 Phone | Cell

Alt-X - Start

(555) 555-5555

Review

Print Medication Review
Select Rxs for review
View Follow Ups

View
Patient Charting
Patient Documents

Patient Med Reviews (8)

Questions | Medical Histary | Non-Prescription Medications | Rxs From Other Pharmacies | General Commentsl Pharmacist Comments

Have you received a MedsCheck review from another pharmacy in the last 12 months <Not Answered> j
Medical Devices - BP Machine =Mot Answereds j
Medical Devices - Glucometer <Mot Answered= j

Medical Devices - Aero Chamber <Mot Answered=> j

-

Profile
All Rxs
Active Rxs
Active Rxs w/Passtimes
Pricing Profile

Mot Disp/OTC Profile

Review

Print Medication Review
When this option is selected, the MedsCheck report screen will appear, allowing you to set

various print options. Configure the appropriate print options. Select Preview to view the
report or Close to exit.

& MedsCheck report (MedsCheck Annual Review, 2014-Jul-14) Bllo =

File
Options
General| Alterate Address | Free Form (Enghsh)l Free Form (French)|
LI Print store logo
[¥! Printin french if patient's language is setto french
V| Show lifestyle
Non-prescription medications

Extralines 3 {Ej

Prepared by =
Pharmacist ~| Line's space 1§
Extra Lines for Prescriptions from other pharmacies
Allergies 0 & Lines 38
Conditons 0 {3 Line's space 2 (&)

Patient Management and follow-up

Lines 3 8
Comment's spacing 60 (3] % )
Sl Line's space 2 (&

Printer \\prntsrvO1\DEV-T650 _vJ Copies 15
Tray  (Default tray) ;j Y| Collate Duplex
PesworeDefouts] [/ Bint ] [ Preview | [ X Close]

14
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Select Rxs for review

If you wish to add/edit Rxs on the Medical History tab, click the button Select Rxs for review.
When selected, the Medication Review Rx Selection screen will appear, allowing you to add
and remove items from the Medical History tab on the MedsCheck Annual Review screen.
Click OK to save any changes and Cancel to close the screen.

« Medication Review Rx Selection BB N
|
Pre-Selected (3) | Other Rxs l Unfills l Not Dispensed | Discontinued
Rx Num Drug Fill Date
¥| 1000962 Synthroid 112mcg 14-Jul-2014
v} 1000961 Prinivil 2.5mg 14-Jul-2014
1 v| 1000960 Amoxicillin 50/ml 14-Jul-2014
Select All | ‘_ Select None }
Drug lines to use in review
Drug line 1 Default L] Drug line 2 Default j
 OK LéCancelj

View Follow Ups

When this option is selected, the Medication Review Follow-ups screen will appear, allowing
you to create follow-up reviews for the patient.

NOTE: This is something that you initiate to follow up with the patient after the MedsCheck
has been completed. This is NOT a MedsCheck Followup review.

w° Medication Review Follow-ups OB o B X8

| Medication Review
| Type  MedsCheck Annual Review Completed On
Patient Doe, Jane Completed By
Follow-ups (0) (F2)[Ins) (Dl
Due Date |Reusan Brand Name IRxNum [P.esolved ] -

[ Close |

15
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To add a follow-up, click Ins and complete the Medication Review Follow-up screen. When you
are finished, click Save.

wf Medication Review Follow-Up ®» Bl|lo @ b4

Medication Review
Type  MedsCheck Annual Review Completed On
Patient Doe, Jane Completed By

Do not follow up
@ Follow up required in 17 days = 31/07/2014

Reason Follow Up Patient - Confirm understanding of Med Review form j

Comment
Resolved on by
Comment
| I ' Save ] [ X cancel |
View

Patient Charting

When this option is selected, the Patient Charting form will appear, displaying information
about the patient’s weight, height, blood pressure, blood sugar, and so on.

« Patient Charting Bl P
Weight Height | Blood Pressure | Blood Sugar | Cholesterol | Creatinine CL [ INR | Clozaril GI<UE]
* et Values (3) (72 (Ins) (el
20 i — | |Date |weight -
S N N REETTEGS
=0 R : . T omenze

08/01/2011 58

o 5
Olantl 0fMartl 0ag  Olull  OfSeptl Ofovil OlJani2 OWMari2 0iMayi2 OlJulZ O01Sepi2 OlhoviZ Oidant

X care

16
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Use the F2, Ins, and Del buttons to modify, insert, or delete information on this screen. Click
Print to print or Cancel to close the screen.

Patient Documents

When this option is selected, the Patient Document List will appear displaying a list of
documents associated with the patient.

= Bg

Patient Document List

& 3k [ Add New Document ¥

Documents [1)
Title Init  |Document Type| Created ¥ | Retain Until |:

tedsCheck Annual Fewview b hAed Review 11/07/2014 ‘

Use the F2, Ins, and Del buttons to modify, insert, or delete a patient document. Click Close to
exit the screen.

Patient Medication Reviews

When this option is selected the Patient Medication Reviews and Dialogs screen will appear,
displaying a history of all reviews for the patient including any that are currently in the
Medication Review queue.

¢ Patient Medication Reviews and Dialogs A == =

N - New Review/Dialog P - Print/Reprint F - Call up C - Cancel Claim | X Close
F2 - View Details Refus

Medication Reviews (1)
Type Status Fee Status Created ¥ |Completed -
MedsCheck Annual Review Printed Paper Review Mot Completed Yet 14/07,/2014

Double-click a Medication Review to view its details. Click Close to exit the screen.

Profile

The Profile menu on the MedsCheck Annual Review screen is identical to the Profile menu on
the patient profile. This menu allows you to view All Rxs, Active Rxs, Active Rxs w/ Passtimes,
Pricing Profile, and Not Disp/OTC Profile.
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Completing MedsCheck ‘Saved for Later’

1. To call up MedsCheck reviews ‘saved for later’ or added to the Med Review Queue via auto

prompting, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

b) The Medication Reviews queue will appear. Select the MedsCheck record you want to

complete and click F - Call Up.

File Edit Patient Profile Reports Utilities MH Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor | F9 - Workflow ” F11 - Drop-off ” F12 - New Rx H Alt-X - Start |

x cancel Patient
e

All Rxs
R - Patient Refused

Last Mame Dukes First Name George Salutation j QK Save

N - New Review/Dialog
F2- View Details

P - Print/Reprint
D - Pharmacist Declined

e - — —— Active Rx
Medication Reviews (7] F2 | (Tns] (Del clive Rxs
Type | status | Fee Status | Created ¥ | Completed | 4 || Active Rxs w/Passtimes
MedsCheck Annual Review Pending Review Mot Completed Yet 15/08/2014 Refillable Rxs
o Deeil

F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the

right navigation pane.

b) The Medication Review queue will appear. Select the MedsCheck you want to complete

and click F - Call Up.

File Edit Utilities NH Workflow Cards Session Help

| F3 - Patient H F5 - Drug

P - Print/Reprint

Medication ReVieWs 5. pharmacist Declined

” F7 - Doctor | Fa - Workflow F11 - Drop-off F12 -

R - Patient Refused

ew Rx Alt-X - Start
£ Refresh

space - Mark Rxs

Dukes, George
Dukes, George
Dukes, George
Dukes, George
Dukes, George

Prescription Drug Program
(BMRS]) - Basic Medication Review Service
(SMMA] Initial Assessment
(SMMA] Initial Assessment
(SMMA] Initial Assessment

Completed Electronic
Completed Electronic
Pending

Printed Paper
Completed Electronic

Patient |Type |Status |Fee Status |Creatad |Cﬂmp|ated | -
Dukes, George MedsCheck Annual Review Pending Review Not Completed Yet 15/08/2014
Dukes, George MB PharmaCheck Medication Check-up Pending Review Mot Completed Yet | 07,05/2014

Pending Claim
Pending Claim

07/03/2014 |07/08/2014
07/08/2014 | 07/08/2014

Review Not Completed Yet 07,/08/2014
Review Not Completed Yet 08/08/2014

Pending Claim

08/08/2014 |06/08/2014

Workflow Actions
Rx's To Do

Rx'sIn Progress
Pending Adjudication (0)
Trouble (0)

Rx Counseling (2)

Medication Reviews (9)

2. Complete steps 3-8 of the Creating an Electronic Medication Review section.

18



\//X !‘Emﬁeﬁn';.'- MedsCheck Reviews - Ontario

Sample Electronic MedsCheck Report

MedsCheck Annual Review
Kredl Pharmscy, 220 Duncan Mill Rd, Toronte ON M3B X5
Fhane: (416) 383-1010 Fao: (416) 383-0001

Have you received aMedsCheck reviewrom anoiher pharmacy in the last 12 monihs [ no |

PATIENT  INFORMATION
[T =

TIEIE ol e e
Doe, Jane Female 05-Mar-1978
Trne [ ke a
100 Yonge 5t Toronto, ON M1M 1M1 {555)555-5555 11411411
[ Family FRysiCian ame Family rr sician Prong Number | Fam JpPrymcan B siation humter
Doctor, Test (22X)222-2322 333333

BT
Acerola (Malpighia Glabra); Agancus Mushroom (Aganicus BEporus); Benzylsogquinoinium Newromuscular Blockers;

Cakasm Channel Blocking Agents-Phenyblylmnes;

[Candiions
Asphyxia, unspecified; Bacllus fragils [B. fragiis] as the cause of dseases chssfied to other chapters;
VialLids Hedicallevices
ChildProol []SnapCap [JePuachine [] Glucometer [] Aero Chamber Mmar Allergy Pump
Alcoholinfake Cafzine lniake Emoking
HModerate Heawy

PATIENT MEDHCATION HISTORY

e Medication Commants
7 TABR Synthrokd 112mog [KNO)
Dr. Te=t Doctiar
Yes |DmysSuspbr 7 Takingwith food

Last Al Date: 2014-07-14T08:15:41
TAKE 1 TABLET ORCE DAILY

30 TAB Prinivil 2.5mg [MSD]

Dr. Te=l Doclor T;lmpn?;m
Yes | D3y Sucok: 30
Last Al Date: 2014-07-14T08:15:07 Sometimesfeeks dazy

TAKE | TABET EVER'Y MORNING

7 ML Amaxicillin 50/ml [SHS]
Dr. Test Doctor

Days Suopk: 7
Last Al Date: 2014-07-14T08:14:16
TAKE 1 TEASPOON(SMLIONCE DAILY

NON-PRESCRIPTION MEDICATIONS | HERBALS | SUPPLEMENTS
Curresitty
taking?

Medication Comments
Yes | Claritin 10 mg For saason aberges

I Do you stop taking medicalion because of unwanted side efeds 7

haci s TR il v Skt Ly A S O0n SRy T D LIS o r. TRARSSu Iy 4 Th i T TRNISA IR S Curman D SRDand S ot B ol By IS COmpiatnals
A fhag ] Fo g Ech dated e
ﬂ'ﬁ&ﬂﬂ%amﬂ D S e B, e o e e B T

Page 10f2
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MedsCheck Annual Review

Do you have trouble remembering to take medications as prescribed ? Yes
Do you think you might benefitfrom a compliance packprogram ? No
Do youconsultyour pharmacistbefore purchasing OTC/herbals/supplement praducts ? No
Doyou changefadjust dosages without consulting your doctor or pharmacist ? Yes

PATIENT MANAGEMENT AND FOLLOW-UP

Date Reason Comments

Follow Up Patient - Confirm understanding of

31-Jul-2014 Med Review form

| understand and agree that my personal information is being collected by Wadland Pharmacy Ltd. and its authorized agents
for the MedsCheck program in order to provide me with a one-on-one consultation with my pharmacist. | hereby

acknowledge receiving both this one-on-one consultation with fny pharm t and a copy of this MedsCheck review.
14-1ul-2014 Z//g& Qfé}?ﬁm

Date F'atlentS|gnat
14-Jul-2014
Preparedon F'harmamst

MedzCheckisa voluntary program =Fnr=or='hytr=3rt=r|o' il
oftl formation prowid tientatthetime th
uneders gof r=h’e:sCra=kpro, ram and the proce:

[=[

'1—.
fessionals within the cir

Page 2 of 2
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Viewing a Completed MedsCheck Review

With Electronic Signatures Enabled

1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

File Edit Patient Profile Reports Utilities

Central Fill

Cards  Session Help

F3 - Patient

F5 - Drug

Last Mame Test

N - New Review/Dialog
F2- View Details
Medication Reviews (7]
Type

F7 - Doctor l F9 - Workflow

F11 - Drop-off " F12 - New Rx " Alt-X - Start l

First Name Pat

P - Print/Reprint

|Status

Salutation

F - Claim Fee

| Fee Status

(F2] (Tng) [Del]
|Created ¥ |C0mpleted | -

MedsCheck Annual Review
MedsCheck Annual Review
MedsCheck Annual Review

General Counseling
MedsCheck Annual Review
General Counseling

MedsCheck Annual Review

Pending
Refused by Patient
Declined by Pharmacist

Completed Electronic
Declined by Pharmacist
Declined by Pharmacist

Completed Electronic

Review Mot Completed Yet
Mo Fee Applicable
Mo Fee Applicable

Mo Fee Applicable
Mo Fee Applicable
Mo Fee Applicable

Pending Claim 30/07/2014 |30/07,/2014

30/07/2014
30/07/2014 30/07/2014
30/07/2014 | 30/07/2014

30/07/2014 | 30/07/2014
30/07/2014 | 30/07/2014
30/07/2014 | 30/07/2014

m

4. The Medication Review View screen will appear. Click the various tabs to see the
Medication Review information that has been entered.

Medication Review View

53]~

MedsCheck Annual Review

Created 30-Jul-2014 03:46 PM Status | Completed Electronic Fee Status | Pending Claim Fee Rx N/A
Started | 30-Jul-201403:46 PM | Duration  Reviewed By | Kroll View Signatures
Completed | 30-Jul-2014 03:46 PM 10secs | Reviewed With | Test, Pat (In Person)

Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Commentsl Pharmacist Commentsl

Have you received a MedsCheck review from another pharmacy in the last 12 months <Mot Answered>

Medical Devices - BP Machine <Mot Answered>

Medical Devices - Glucometer <MNot Answered >

patient’s electronic signature.

Scanned Reviews with Manual Signatures
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

Click Print to print the Medication Review, or View Signatures to view the pharmacist’s or
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4. The Medication Review View screen will appear. The Review tab displays information
entered on-screen during the Medication Review; the Documents tab displays the scanned

image of the signed Medication Review. Scanned paper Medication Reviews is also viewable
from Patient Documents.

Medication Review View - — . - [EHIIR
MedsCheck Annual - LTC Home Resident
Crested  30-Jul-201402:25PM Status Completed Electronic Fee Status Claimed FeeRx 1087677

Review Documentsl

Started 30-Jul-2014 02:25 PM Completed | 30-Jul-2014 02:26 PM Duration  1m Os Vie jnature L Print J

Reviewed By | Scott Belfer Reviewed With | Belfer, Scott (In Person)
Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments l Pharmacist Comments |

Have you received a MedsCheck review from another pharmacy in the last 12 months No

Medical Devices - BP Machine Yes

Medical Devices - Glucometer Yes

5. Click Print to print the Medication Review.
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Paper MedsCheck Reviews

This section explains how to perform paper MedsCheck reviews. Paper MedsCheck reviews
must be completed on paper, signed, and scanned back into the system.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring ODB MedsCheck Prompt

The system prompts for MedsCheck when the option Prompt for ODB Med Checks is enabled
under File > Configuration > Store > Rx > Prompting.

w’ Store Level Configuration Parameters

= PG

| Generall F'atientl Dirug I Doctorl

atd | FDE I Adiudicationl Labelsl Heportsl Securit_l,.ll Interfacesl Drderl X-.-’-‘«F!I Y -To D0|

[ ctri (=)

i Eenerall 2-Pricing 3~ F'mmpting| 4 - Nursing Hnmel 5 - Background R FiIIingI E -Wc-rkflc-wl 7- Counselingl 8- Cthvc|

[ Prompt ta use Drug Subs [ Adtomatically use Drug Subs
[7] Use Drug Subs when Batching
[] Prompt If Doctor Refused Repeat when Canceling Rz
Frompt for Commerts when Cancelling an Fix
[ Adways require camment
Frompt for Comments when Inactivating an R
[ Ahways require comment
[] Prampt far Patient Caunzelling on new Fx
[ Prompt ta Bateh MH Rxs
Frompt when not dispensing as diug's Pack Size
[ Prampt Far Repeats When Copving an Rx
[ Prampt Ta Use Manual Price Fram Last Refil
[7] Remove Manual Price for Batched Rxs
[] Prompt if Doctor Autharization Received for Nareotic Rxs
[ Check for High Intenzity Drugs
Prompt if there is not enough inventory o fill the Rx
[] Prevent Copying an Inactive Rx to a New Murmber
[] Show local patient profile on fil
Prompt to Copy "Migtake’ Rxz to a Mew Mumber
[] Shaw thermal/dot matrix label config on autafil

[ Prampt ta Prirt Seript Image for 1t Fill of an Unfiled Rx
[ Prompt for &40L Plan Information if S4 number is MOT sst

[] Farce ODE Fee Restrictions
[ Prompt if waz Undeliverable when Cancelling an Rix

[rug Programs
[ Participate in the Rix Canada / Health Infarm Pragram

[] Patticipate in the Pharmacy Access program
[] Use Station Mame Subdirectories For Pharmacy Access
Days Back: 365

[7] Enable Rx Canada Program [RxGateway)

Services
[ Prompt ta Enrol Patients in Refil Reminder or Auto Refill Pragram
Frompt to Enrol HH Patients in Refill Beminder or Auto Refill Program
[] Prampt ta Enable Rxs far Refil Reminder and Auta Refill Program

=
=

Frompt to copy workflow packaged info for cancel and refill Riss
Prompt to copy to neve number if refiling an B with no repeats
Prompt far Due D ate an aubofil batches

[] Prompt for Tx comment on autofil batches

Enral Patients far Pickup Matification Mo

Enral MH Patients for Pickup Matification Ma

Save Route code from Rx as default value if no default is et Ask

Save Form code from Re a5 default value if no default is st sk j
Autarnatically Apply Elzton For Eligible Products (Do nat prampt]
Frompt for ODE ted Checks
[ Track ODB Med Checks Rejection Reasans
[] Al ‘Mever Prampt' Far ODB Med Checks

7o
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When the option ‘Prompt for ODB Med Checks’ is enabled, the system screens each patient for
MedsCheck eligibility every time an Rx is processed. If the patient is eligible, the user is
prompted and presented with a number of options as shown below.

w* Select an Option = =

This patient may be eligible for the MedsCheck Annual Review program.

| Print Report Mow |

| Print Report Later |

| I have Other Rxs to fill for this patient |

| Do not prompt me until the next time the patient comes in. |

| Do not prompt until ... |

| Never Prompt for this patient |

e Print Report Now: This will call up the Medication Review report so you can select the
items you would like to print on the report.

e Print Report Later: This places a record in the Medication Review queue allowing you to
print the Medication Review at a later date or time. See section ‘Completing MedsCheck
‘Saved for Later’ for further details.

o | have Other Rxs to fill for this patient: This will allow you to continue filling more Rxs
for the patient before printing the report.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

e Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.
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Creating a Paper MedsCheck Review (Manual)

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help

F3 - Patient

F5 - Drug F7 - Doctor ’ Fo - Workflow " F10 - Pickup ” F11 - Drop-off " F12 - Mew Rx " Alt-X - Start

‘Comments (0)
Topic

Comment

0DB 999999999999

General l Family 1
Acacia (Acacia Senegal, Gum Arabic)

Mursing Humel Cupay;] Ccmmgmcatluns] Other ]

Plans (1)
| subPlan Code| Group 1D | client 1D |Ewiy |
1 oDs 999999999999 | 31/12/2014
Allergies (2)

Last Name  Kroll First Name Test salutation j [ ok Save Patient
Address1 123 Any Street Phone Numbers (1) [F2] (] (De1] Birthdate  21/03/1950 Profile
Description |Phune | All Rxes
Address 2 Age 64 years
J J Home (555) 766-8042 J Active Rxs
City Taronto | Prov ON = Gender Female - i i
" No Jmagelalable Active Rxs w/Passtimes
Postal ALK AXS County Canada = tenguage English | —
illable Rxs

Email Family Doctor Height . "

Pricing Profile
Quick Code KROLL Anthes, David Weight load | Delete

Mot Disp/OTC Rxs
R Filled in Error
Suspended Rxs
Perform FDB Analysis

View
Alternate Addresses

[Ectrl B AR Profile

. Batches
Patient Consent
Ammonium Acryloyldimethyltaurate/ VP C Active Consent Unknown Charting
Consent
A I
nimal - [] Unit Dose e
Deceased On Type <Mene> j redit Cards
Medical Conditions (1) Ins] . Documents
- - Prescriptions Cycle <Mone> j
Acute Intestinal Amebiasis ) Medication Review/Dialogs (0) I
Delivery Type  Default (Pickup) v|  PriceGroup  <Default> (<Nones) |
; Rx Counseling History
Delivery Route -‘ T anl

3. The Medication Review queue will appear. Click N — New Review/Dialog.

w¥ Patient - Helvey, Ricky

P B|o B R

File Edit Patient Profile Reports

F3 - Patient

LastName Helvey

IN - New Reviewaiangl

F5 - Drug

Medication Reviews [0])
Type

Utilities  WH  Central Fill Cards

Session Help

F7 - Doctor

Fa - Workflow “ F10 - Pickup ” F11 - Drop-off " F12 - New Rx ” Alt-X - Start

First Name Ricky

Status

Salutation

Fee Status

Profile
All Rxs
Active Ras
Ihs)
Created ¥ | Completed » | Active Rxs w/Passtimes

Refillable Rxs

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown
menu and click Print Now. If you wish to add to the Med Review queue in order to print the

Medication Review later, click Save for Later.

= Medication Review/Dialog

B3]

Type

MedsCheck Annual Review

=

I Print Now I lga\reforlaterl l X cancel l

5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the

Rxs you want included in the report. When you are finished, click OK.
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w* Medication Review Rx Selection ®E|=E 3
Pre-Selected (3) | Other Rxs | Unfills | Not Dispensed | Discontinued |
Rx Mum Drug Fill Date
1000958 Amoxicillin 50/ml 11-Jul-2014
1000957 Prinivil 2.5mg 11-Jul-2014
1000956 Synthroid 112mecg 11-Jul-2014
Select All ] ’ Select None ]

Drug lines to use in review

Drug line 1 Default

W OK

j Drug line 2 Default

E

click Print. The report will generate.

the patient do the same.

The Medication Review Report form will appear. Select the appropriate print options and

Complete the MedsCheck review on the form. Sign the Medication Review Report and have
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Scanning MedsCheck Reports

8. From the Alt-X Start screen, go to Utilities > Printed Document Scan/Import.

File Edit Reports [Utilities | Central Fill Cards Session

Help Version 10

F3 - Patient [

Last Rx Numbers

1000
9000
Modify R

Reprint R

Cancel Ry

Modify Specifi
Reprint Specifi
Counsel R

Drug Ordering
Merge

Unmerge

Adjust Current Wait Time
Check Interactions
Quick Price

Delivery Orders

View Mail/Messages

View Packager Batches

View Pending Metwork Queue
Labels

Script Reentry Mode

Credit Card Password Manager
Database Maintenance

Drug

Patient/Rx Import

Y }kﬂow " F11 - Drop-off " F12 - New Rx “ Alt-X - Start ]
3

Alt+=

Followups

0-1hrs  1-4 hrs 4+ hrs  Tomarrow  Trouble Total
0 0 0 0 0 4 R Counts
Mew Rxs 0
0 0 0 0 0 4 Repeat Rxs 0
3
Total Rxs 0

Printed Document Scan/Import

9. The Import Scanned Documents screen will appear. Place the report pages face down on
the scanner hopper. Check Scan both sides of paper if you are scanning pages with
information on both sides and your scanner supports dual side scanning. Click Start

Scanning.

7
Import Scanned Documents

B~

Scanner
Scanner
Mode

Resolution 100

FUJITSU fi-6130dj
Colour

IScan bath sides of paper [[] I

Document Processing
To Process 0

To Reconcile @

Wiew Scan History

[ Process and Reconcile ]
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10. When scanning is complete, the screen will indicate how many pages were scanned

successfully and how many will need to be manually reconciled. When you are finished,
click Process and Reconcile.

Impart Scanned Documents B/ =

Scanner

Scanner  FUJITSU fi-6130Zdj #2

Maode Colour
Resolution 100 Scan both sides of paper [

Document Processing

To Process 0 I Process and Reconcile I

To Reconcile @

Wiew Scan History

11. The Document Scan Reconciliation screen will appear. Items ready to be processed will
appear in the Documents to be created section. Iltems that need to be reconciled will
appear in the Unprocessed Images section.

w Document Scan Reconciliation *rE|lo= P9

Documents to be created (1)

Scanned on Status Filed By Type Title Patient RxMNum |Pages| Mescage -
11/07/2014 12:31:43 | Ready To File evie L

Process
L Pending
Documents
B F|zooms500 Q& DBE B B Unprocessed Images (0)| Current Document
» | Document Images [(2) (Del) (#4) (74
MedsChek Armual Review Scanned On| Type # Info Message -
R S 123143 | Patient bled Revie| 1
1231:45  Patient Med Reviey 2
Hnapa mrshed s Uan . r v . [ e ]
PATHNT BEARMATION
b T T
Coe Jane Temake O Her 1570
e e o =
100 Vange 5 Treastn. ON L1M 1M1 (KERIRES GERT ERCERET] -
¢ TR Decror, Test e (azpaz-aaz - nomn .
CPAB (MDD RAEI) AQALS MUETCO (AGTCUS AOr 1) RANYEEM! TR HPLTSUSELES FRESTS
CakumiChannel Elooong dgen sEh emyakolamings;
—
Maphios, wrapecfied; Biillus fraghs [3. faghe] as the Sause of dssases causfac tosther chapters;
T T
[ onispeoct [Jonsecap [ aoitaeire (] Sucomtm [Jawochansr Fie: Alorgy Pump
Aroirace wemsieimars smang
it ey o
PATIENT MEDICATION HISTONY =
o Hadicdior Comrrants
ZTAD Syathred 112meg [KHC]
ity
Ve |Onwiopphs 7 Takingwithfoed
Last Al Dare: 2114-07-14TOSL 581
:;_n_rrmm:iz.mg =]
7=
Elzimam racag :
" [ st 0 rona s Somatee ot diry Document Type Patient Med Review j
TAVE £ TALET B ORI
;ﬂ% wilﬂ“[&nﬂ]
ki Patient -
el mﬂﬂaﬂ‘ﬂ\d-"?-'-'ﬂi'llqﬁ o F3
TARE 1 TRASHHOCH L JONE DALY
Name Doe, Jane DOB 24/10/1950
NCOMNPRESCRIPTION UEDICATIONS J FERBALS | SUSP_EUENTS 1w v s
=g dnseine | prm— | Address COgesE
| res [ s | | City, Prov Toronto, ON
[Gommaron manaawson vomvos o e aare o~ v ]
ey p Med Review
11/07/2014 - MedsCheck Annual Review (Printed Papej
Brightness Contrast Saturation
0 0 1] | X cancel ] [ " Mext ]
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12. If all Rxs were scanned successfully and appear in the Documents to be created section,
click the Process Pending Documents button. Click Cancel to close the screen.

Billing a MedsCheck Review

13. Once scanning is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

14. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

Completing MedsCheck ‘Saved for Later’

1. To call up MedsCheck reviews ‘saved for later’, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

b) The Medication Reviews queue will appear. Select the MedsCheck record you want to
complete and click F - Call Up.

File Edit Patient Profile Reports Utilities NH Central Fill  Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor | F2 - Workflow F11 - Drop-off H F12 - New Rx ” Alt-X - Start |
Last Name Doe First Name Jane Salutation Ms. j [o]'8 X scan [T

Profile
AR

R - Patient Refused

N - New Review/Dialog P - Print/Reprint
F2- View Details
Medication Reviews [15]
Tppe | Status
MedsCheck Annual Review Pending

D - Pharmacist Declined
Active Rxs

=
By
&|
&
o
|

|Fee Status Active Rxs w/Passtimes

Review Not Completed Yet

|Clealed T |C0mpleled |
20/08/2014

»

Refillable Rxs

F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the
right navigation pane.

b) The Medication Review queue will appear. Select the MedsCheck you want to complete
and click F - Call Up.

File Edit Utilities NH Workflow Cards Session Help

Dukes, George
Dukes, George
Dukes, George
Dukes, George
Dukes, George

Prescription Drug Program
(BMRS] - Basic Medication Review Service
(SMMA] Initial Assessment
(SMMA) Initial Assessment
(SMMA] Initial Assessment

Completed Electronic
Completed Electronic
Pending

Printed Paper
Completed Electronic

Pending Claim
Pending Claim

07/08/2014 |07/08/2014
07,08/2014 |07/08/2014

Review Mot Completed Yet | 07,05/2014
Review Mot Completed Yet | 06,05/2014

Pending Claim

06/03/2014 |06/08/2014

| F3 - Patient H F5 - Drug | F7 - Doctor | F9 - Workflow F11 - Drop-off F12 - New R Alt-X - Start
M d o R c P - Print/Reprint &> Refresh Workflow Actions
€ |Cat|0n eviews D - Pharmacist Declined R - Patient Refused  space - Mark Rxs Fx's To Do

Patient |Type |Status |Fee Status |Created |Comp|eted | - Rx'sIn Progress
Dukes, George MedsCheck Annual Review Pending Review Not Completed Yet 15/08/2014 Pending Adjudication (0)
Dukes, George ME PharmaCheck Medication Check-up Pending Review Not Completed Yet 07,/08/2014

Trouble (0)
Rx Counseling (2)

Medication Reviews (9)

2. Complete steps 4-14 of the Creating a Paper MedsCheck Review section.
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Sample Paper MedsCheck Report

MedsCheck Annual Review
Krodl Pharmscy, 220 Duncan Mill Rd, Toronte ON M3B 3)5
Fhone: (416) 383-1010 Fac (416) 383-0001

Have you received a MedsCheck review from another phamacy in the last 12 months [ no |

PATIENT  INFORMATION

[T [==F= THlE ol Gl
Doe, Jane Femake: 05-Mar-1978
Triore L ke
100 ¥onge 5t Toronto, ON M1M 1M1 (555)555-5555 11131411
[Family FRysician ame Family PRy aicin Frone NamBer | Family Phiysician Becsration Number
Doctor, Test (222)222-2322 333333

[ ATeT s
Acerola (Malpighia Gabra); Agaricus Mushroom (Aganicus Beporus); Benzylsoquinolinum Newromuscular Blodkers;

Cakcasm Channel Blocking Agents-Phenyblyamines;

[Canditions
Asphyia, unspecified; Bacilus fragiis [B. fragis] as the cause of dseases chssfied to other chapters;
Viallids Hedicallievices
ChilgProol [] Snap Cap [JePuachine [] Glucometer [] Aero Chamber Mmar Allergy Pump
Alccholinfake Calzine imiake Emaoking
HModerate Heawvy

PATIENT MEDMCATION HISTORY

e Medication Cormmants
T TABR Synthrokd 112maog [KNG)
Dr. Tm=t Dot
Yes |O:sSusph: 7 Takingwith food

Last Al Date: 2014-07-14T08:15:41
TAKE 1 TABLET ORCE DALY

30 TAB Prinivil 2.5mg [MSD]

Dr. Te=t Doclor ok Sam
Yes | Doy Sucpd: 30
Last £l Date: 2014-07-14T0B:15:07 Sometimes feek duzy

TAKE 1 TASLET EVERY MORNING

7 ML Amaosicillin 50/ml [SN5]
Dr. Te=t Doclor

Dayvs Supple: 7
Last Al Date: 2014-07-14T08:14:16
TAKE 1 TEASPOON{SMLIONCE DAILY

NON-PRESCRIPTION MEDICATIONS / HERBALS | SUPPLEMENTS

Currefitly
taking 7 Medication Commemnts
¥es |Claritin 10 mg Faor season alerges
Il:lnynushup taking medication because of unwanted side efledts 7 | Yes |

Mbstn C o sl v s Ly mwm&gw_qu:mlhw a‘wﬂlmmﬂrﬂuﬁmluﬂlﬂﬂumqmm:
ﬂm&ﬂﬂ%mﬂ’_"“'ﬂ'f‘“ e eTe st e b i e B Rl T

Page1ol3
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MedsCheck Annual Review

NON-PRESCRIPTION MEDICATIONS / HERBALS / SUPPLEMENTS

C t -
t"ﬁ'[(riﬁg?m Medication Comments

PRESCRIPTIONS FROM OTHER PHARMACIES
Currenthy

taking? Medication Comments

Yes| Mo

Yes | No

Yes| Mo

Do you stop taking medication because of unwanted side effects ? Yes | No
Cioyou have trouble remembering to take medications as prescribed ? Yes | No
Doyou thinkyou might benefitfrom a compliance pack program ? Yes | No
Do youconsultyour pharmacistbefore purchasing OTC/herbals/supplement products 7 Yes | No
Do you changefadjustdosages without consulting your doctor or pharmacist ? Yes | No
Doyou have trouble remembering totake medications as prescribed ? Yes | No
Do you think that you might benefitfrom a compliance pack program ? Yes | No
Dioyou stop taking medication because of unwanted side effects ? Yes | Mo
Dayou changefadjustdosages without consulting your doctor or pharmacist ? Yes | Mo
Do youconsultyour pharmacistbefore purchasing OTC/herbals/supplement products 7 Yes | No

PATIENT MANAGEMENT AND FOLLOW-UP

Date Reason Comments

MedsCheckisa voluntary program s ponsoredby the Ontariogovernment. Theacouracy of thein fon
of theinformation provided by the paliarlatlratirratra1.’=_~:50rack'.\'asj)ra ared. The signed
understanding of the MedsChethk program and the process; the completed MedsCheck rray’ba =l

Page 2 of 3
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MedsCheck Annual Review

PATIENT MANAGEMENT AND FOLLOW-UP

Date Reason Comments

| understand and agree that my personal information is being collected by Wadland Pharmacy Ltd. and its authorized agents
for the MedsCheck program in order to provide me with a one-on-one consultation with my pharmacist. | hereby
acknowledge receiving both this one-on-one consultation with my pharmacist and a copy of this MedsCheck review.

Date PatientSignature
11-Jul-2014
Preparedon Pharmacist

Med SC heckisa voluntary program =Enr soredby the Ontariogow: =-rr‘_\rr=-r‘l( Thescou rg'"y?_ f theinformation inthi |5 docy rr=-rl p=-r 4z on traa::L rg'"yqr
=g e

rmiation provid n
AN "=-r=t=r"|r of thebled ;...ra“k pro" ramandtheprocess; the complzted MadsCheck rr=y=b=-

Page 3 of 3

shan

sorrrplatarass

H n
I'otl'—'hrraaltr xr=pro fzszianzizwith |r?u=- of care.
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Viewing a Completed MedsCheck Review

1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.
3. Highlight the completed Medication Review and click F2 - View Details.

4. The Medication Review View screen will display the scanned image of the completed
Medication Review. Scanned Medication Reviews are also viewable from Patient
Documents.

Medication Review View - - - B = ]
MedsCheck Quarterly Monitoring - LTC Home Resident
Created 30-Jul-2014 02:34 PM Status  Completed Paper Fee Status | Claimed FeeRx 1087678

2014-07-30 2:39 PM l

B & & |zoom953 % S ‘ﬂ,@ﬁ ] L)

MedsCheck Quarterly Monitoring - LTC Home Resident

m

LOCATION OF THE ASSESSMENT

e Address |
\ \

| understand and agree that my ion Is bein 1l d by Wadland Ph:

M iuthonze:goanu forthe MedsCheck program In °'dg" to P"°V|d°y"‘° with a one-on- m:‘?on’;ga‘:t?’o:’xig:‘acy 3

MadnChock roview. a Sothvlis ! with my ph and a copy of this

[/

: / / a4
Date / Pdtient Signature
7/

//4/ Y A i

red orf \ Scott Belfer

Brightness Contrast Saturation

U U U
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Declined and Refused MedsCheck Reviews

This section explains the process for recording MedsCheck reviews that have been declined by
the pharmacist or refused by the patient.

NOTE: The medication review records that are declined by the pharmacist or patient refused
can also be noted from the Medication Review queue on the F9-Workflow screen.

Pharmacist Declined
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate MedsCheck review and click D — Pharmacist Declined.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor | F9 - Workflow ” F11 - Drop-off ” F12 - MNew Rx ” Alt-X - Start
Last Name Test First Name Pat Salutation j oK Save X scan

N - New Review/Dialog P - Print/Reprint F - Call up

F2 - View Details | D - Pharmacist Declined | R - Patient Refused

Medication Reviews (2] [F2] [Tns] (Del]
Type |Status |Fee Status Created ¥ | Completed | -
MedsCheck Annual Review Pending Review Mot Completed Yet 30/07/2014

General Counseling Pending Review Mot Completed Yet 30/07,/2014

4. Select the appropriate option from the Decline/Refuse prompt.

I wf Select an Option |E| [dz-r

Decline/Refuse - MedsCheck Annual Review.

| Do not prompt until the next time the patient comes in. |

| Do not prompt until ... |

| Never Prompt for this patient |

| Cancel |

e [f you select Do not prompt until the next time the patient comes in, no further action
is required until the next time the patient visits the pharmacy.

e If you select Do not prompt until... you will be prompted to specify the next time you
want to be prompted for the patient’s MedsCheck review. Complete the form and click
OK.
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e [f you select Never Prompt for this patient you will not receive any additional

MedsCheck prompts for the patient.

Patient Refused

1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate MedsCheck review and click R — Patient Refused.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F11 - Drop-off “ F12 - Mew Rx “ Alt-X - Start

F3 - Patient F5 - Drug F7 - Doctor l F9 - Workflow

Last Name Test First Name Pat Salutation j oK Save X scan

N - New Review/Dialog P - Print/Reprint F - Call up

F2- View Details D - Pharmacist Declined | R - Patient Refused |

Medication Reviews [2) F2][Tns] (Del
Type |Status |Fee Status Created ¥ | Completed | -
MedsCheck Annual Review Pending Review Mot Completed Yet 30/07/2014

General Counseling Pending Review Mot Completed Yet 30/07,/2014

4. Select the appropriate option from the Decline/Refuse prompt.

[ &’ Select an Option |E| [&J

Decline/Refuse - MedsCheck Annual Review.

I Do not prompt until the next time the patient comes in. ‘

I Do not prompt until ... ‘

I Never Prompt for this patient ‘

I Cancel ‘

o |f you select Do not prompt until the next time the patient comes in you will be
prompted to specify if the review was declined by the Patient or Someone Else.
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o If you select Someone Else, the Medication Review/Dialog Refusal form will
appear. Click the lookup button next to the Select agent field to search for the
patient who refused the review. Select a relationship from the Relationship to
patient menu and click OK.

( & Medication Review/Dialog Refusal |E|L£_hJ
Refused By _) Patient @ Someone Else
Select agent Doe,lane j
Last name Doe
Eirst name Jane
Relationship to patient@ vI
| ok | I X Cancel‘

o No further action is required until the next time the patient visits the pharmacy.

e [f you select Do not prompt until... you will be prompted to specify the next time you
want to be prompted for the patient’s MedsCheck review. Complete the form and click
OK.

e [f you select Never Prompt for this patient you will not receive any additional
MedsCheck prompts for the patient.

NOTE: MedsCheck review records that have been either refused or declined cannot be
deleted from the Medication Reviews queue.
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MedsCheck Review Statuses

This section explains the statuses that appear in the Medication Review queue at various
stages throughout the MedsCheck review process.

Statuses

File Edit Patient Profile Reperts Utilities NH  Central Fill Cards Sessjon Help

F3 - Patient F5 - Drug F7 - Doctor F9 - Workflow || F11 - Drop-off || F12 - Mew Rx || Alt-X - Start |
Last Name Doe First Name Jane Salutation Ms. j oK Save X cancel Patient
Profile
N - New Review/Dialog P - Print/Reprint F - Call up All Rxs
F2 - View Details D - Pharmacist Declined R - Patient Refused 8
— Active Rxs

,,
S
3
&

=
| 1

Medication Reviews [5]
Type Status

Fee Status Active Rxs w/Passtimes

»

Created ¥ | Completed |

MedsCheck Annual Review
MedsCheck Annual Review
MedsCheck Annual Review
MedsCheck Annual Review
MedsCheck Annual Review

Pending

Printed Paper
Completed Electronic
Declined by Pharmacist
R_efused by Patient

Review Mot Completed Yet
Review Mot Completed Yet
Pending Claim

Mo Fee Applicable

Mo Fee Applicable

15/08/2014
31/07/2014
06/08/2014 | 06/08/2014
11/07/2014 11/07/2014
19/08/2014 19/08/2014

m

Refillable Rxs
Pricing Profile
Mot Disp./OTC Ruxs
Rxs Filled in Error

Pending
Reviews that have been initiated but have not yet been completed.

Printed Paper
Reviews that have been printed but have not yet been billed.

Completed
Reviews that have been printed and billed.

Declined by Pharmacist
Reviews that have been declined by the pharmacist.

Refused by Patient
Reviews that have been refused by the patient.
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Fee Statuses

File Edit Patient Profile Reports Utilities MH Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Docto F9 - Workflow F11 - Drop-off H F12 - MNew Rx || Alt-X - Start |
Last Name Doe First Name Jane salutation Ms. j oK Save x cancel Patient
Profile
N - New Review/Dialog P - Print/Reprint F - Call up All Rxs
F2 - View Details D - Pharmacist Declined R - Patient Refused Active R
Medication Reviews [3) (2] (Tng) (Del) ctive Rxs
Tupe |5tatus Fee Status Created ¥ |Comp\eted | o Active Rxs w/Passtimes

MedsCheck Annual Review
MedsCheck Annual Review
MedsCheck Annual Review

Pending
Refused by Patient
Completed Electronic

Review MNot Completed Yet
Mo Fee Applicable

Pending Claim 06/08/2014 06/08/2014

19/08/2014
19/08/2014 |19/08/2014

m

Refillable Rus
Pricing Profile

Review Not Completed Yet

Reviews that have been initiated but have not yet been completed.
No Fee Applicable

Reviews with no associated fees (usually declined or refused reviews).

Pending Claim
Electronic reviews: Completed reviews with a Status of Completed.
Paper reviews: Reviews that have been printed and the option Require Document scan to

complete Paper Med Review is off, and reports that have been printed and scanned back into

the system if this option is enabled.
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